
В предыдущих статьях, посвящен�

ных работе с программой Altium

Designer, было рассказано о приёмах

разработки библиотек и электричес�

ких принципиальных схем (СЭ №№ 6,

7, 2008). После создания схемы была

выполнена компиляция, и теперь

проект готов к разработке печатной

платы, процесс которой условно

можно разделить на несколько са�

мостоятельных этапов:

● разработка конструктива платы;

● создание правил проектирования;

● размещение компонентов;

● трассировка;

● проверка правил проектирования

(DRC);

● отладка и подготовка технологи�

ческих файлов для производства.

В данной статье будут рассмотрены

все вопросы, касающиеся первого эта�

па разработки платы, а именно оформ�

ления конструктивных параметров.

Под разработкой конструктивных

параметров подразумевается этап, на�

чинающийся формированием файла

платы и завершающийся размещени�

ем компонентов. Этот этап состоит из

четырёх шагов: формирование конту�

ра печатной платы, описание стека

слоев, установка крепёжных отверс�

тий и определение запрещённых зон

для трассировки. Прежде чем присту�

пить к вышеупомянутым действиям,

необходимо сформировать в Altium

Designer новый файл печатной платы

и разобраться с настройками, кото�

рых в редакторе печатных плат нам�

ного больше, чем в редакторе элект�

рических схем.

Начнём с создания нового файла

печатной платы, причём не будем

привязывать эту плату к какому�либо

ранее созданному проекту, для чего

выполним команду File > New > PCB. В

панель Projects будет добавлен новый

файл с расширением *.PcbDoc, обоз�

начающим файл печатной платы в

программе Altium Designer. При соз�

дании файла *.PcbDoc он становится

активным, т.е. запускается редактор

печатных плат.

Файлу, вновь появившемуся в пане�

ли Projects, следует присвоить уни�

кальное название, для чего на нём

следует нажать правой клавишей мы�

ши (ПКМ) и выбрать команду Save.

При создании новой платы редактор

Altium Designer открывается в дюй�

мовой системе координат, поэтому

перед разработкой геометрии платы

необходимо сделать пользовательс�

кие настройки. Как говорилось ранее

(СЭ № 5, 2008), настройки редактора

плат делятся на две группы: настрой�

ки текущего документа и настройки

всего редактора. Настройки всего ре�

дактора на данном этапе большого

значения не имеют и будут рассмот�

рены в последующих статьях, а уста�

новка параметров текущего докумен�

та производится в окне Design > Board

Options. Здесь необходимо выбрать

метрическую систему координат и

установить значение 2,5 мм для шага

сетки Snap Grid.
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В очередной статье серии рассмотрены вопросы первого этапа

разработки печатной платы, касающиеся оформления

конструктивных параметров.

Altium Designer Summer 08 –
Разработка конструктивных
параметров печатной платы

Алексей Сабунин (Москва)
ФОРМИРОВАНИЕ КОНТУРА

ПЛАТЫ

Создание платы начинается с фор�

мирования её контура, для чего ис�

пользуется группа команд меню

Design > Board Shape, из которых наи�

более востребованными являются:

● Redefine Board Shape – рисование

контура платы вручную;

● Define from Selected Objects – форми�

рование контура платы из выделен�

ных объектов;

● Define from 3D Body – формирова�

ние контура из трёхмерной модели

(работает только в трёхмерном ре�

жиме);

● Define Board Cutout – формирова�

ние выреза в плате.

Рассмотрим на примере каждый из

этих инструментов. Итак, для создания

контура платы вручную выполним ко�

манду Design > Board Shape > Redefine
Board Shape, после чего курсор мыши

переходит в режим рисования, сход�

ный с инструментом Place Line. Теперь,

фиксируя левой кнопкой мыши (ЛКМ)

углы контура платы, можно нарисо�

вать граничный рисунок, а комбина�

цией клавиш Shift+Space можно перек�

лючать режимы ортогональности для

использования дуг и острых углов.

При использовании дуги её радиус

изменяется комбинациями клавиш

Shift+«.»(точка) и Shift+«,»(запятая).

Следует отметить, что данный

инструмент позволяет создавать

только простые контуры. В режиме

рисования бывает сложно позицио�

нировать курсор в необходимой точ�

ке, поэтому координаты углов во вре�

мя рисования контура можно вво�

дить с клавиатуры. При активной

команде следует нажать клавишу J, за�

тем клавишу L, после чего на экране

появится окно Jump To Location, в ко�

тором предлагается ввести коорди�

наты. Описанная команда перемеща�

ет курсор в указанную точку, а для

фиксации точки контура необходи�

мо после каждого ввода координат

нажимать клавишу Enter.Рис. 1. Импорт формата AutoCAD (DXF, DWG)



Например, чтобы создать контур пла�

ты в виде прямоугольника 32,5 × 46 мм,

следует выполнить команду Design >

Board Shape > Redefine Board Shape, а

затем, не трогая мышь, вводить пос�

ледовательно координаты следую�

щим образом: J > L > {100,100} > Enter

> J > L > {100,132,5} > Enter > J > L >

{146,132,5} > Enter > J > L > {140,100} >

Enter и закончить формирование

контура нажатием ПКМ.

Данный метод не отличается прос�

тотой и поэтому практически не ис�

пользуется. В большинстве случаев

контур платы изначально создаётся в

механической САПР, а затем импор�

тируется в формате DXF или STEP.

Рассмотрим оба этих варианта.

Для создания контура платы вос�

пользуемся заготовкой, созданной в

программе AutoCAD и сохранённой в

формате DWG(DXF) (см. файл Пла�

та2000.DWG из папки Example на сай�

те www.soel.ru). Для использования

файла в формате DWG(DXF), нахо�

дясь в редакторе печатных плат, вы�

полним команду File > Import. В стро�

ке «Тип файлов» следует указать

AutoCAD, после чего выбрать исход�

ный файл с будущим контуром пла�

ты. На экране появится окно, пока�

занное на рисунке 1, в котором необ�

ходимо задать единицы измерения в

группе Scale (по умолчанию установ�

лены mil – в этом случае контур будет

уменьшен в 2,54 раза).

Остальные настройки не обязатель�

ны, но рекомендуется определить рас�

положение начала координат вставля�

емого рисунка в окне Locate AutoCAD и

выбрать слои для импорта. При выбо�

ре слоёв следует указывать, на какой

слой Altium Designer будет передана

импортируемая информация. Для

контура платы обычно используется

графический слой Mechanical 1, поэ�

тому именно он был выбран напротив

исходного слоя Layer, при этом для

слоя 0 выбрана настройка Not
Imported (не импортировать).

После установки всех параметров

в соответствии с рисунком 1 нажи�

маем кнопку ОК, и в рабочей области

редактора появляется импортиро�

ванный контур. Теперь программе

необходимо указать, что этот контур

является границами платы. Для этого

выделяем весь импортированный

контур и выполняем команду Design >

Board Shape > Define from Selected
Objects, после чего область внутри

контура становится чёрной, а снару�

жи – серой, что свидетельствует о

корректном создании платы.

Создание контура платы посред�

ством импорта сложного контура из

механических САПР в формате DXF

(DWG) является наиболее удобным,

но не обладает возможностью взаи�

мообратного редактирования. Пояс�

ним, о чём идёт речь. В последней

версии программы имеется возмож�

ность в качестве платы использовать

внешнюю модель в формате STEP,

при этом, если в исходной программе

изменяется контур платы или отверс�

тия, они автоматически сохраняются

в начальную модель STEP и перено�

сятся в Altium Designer.

Рассмотрим процедуру создания

ссылки на модель STEP в качестве

контура платы на конкретном приме�

ре. В качестве заготовки воспользу�

емся моделью плата.STEP из папки

Example. Прежде чем приступить к

подключению данной модели, вы�

полним некоторые подготовитель�

ные действия. Во�первых, сделаем

«откат» (Ctrl+Z) последних действий,

чтобы убрать ранее созданный кон�

тур платы. Во�вторых, для использо�

вания возможности задавать ссылки

на модели STEP необходимо в наст�

ройках заранее указать расположе�

ние папки с моделями, для чего отк�

роем окно DXP > Preferences > PCB
Editor > Models. В появившемся окне

следует нажать кнопку и указать путь

к расположению моделей, в нашем

случае …/example (в которой нахо�

дится файл плата.step), после чего на�

жать кнопку Add. В списке подклю�

ченных папок с моделями появляется

новая ссылка, после чего нажимаем

кнопку ОК (см. рис. 2).

59СОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 8 2008 WWW.SOEL.RU

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ

Рис. 2. Подключение папки с моделями STEP

Рис. 3. Новый режим работы панели Project –

работа с 3D#моделями



Чтобы использовать STEP�модель

платы, ранее созданной в механичес�

кой САПР, необходимо переключить�

ся в трёхмерный режим работы. Пе�

реключения между двумерным и

трёхмерным режимами работы вы�

полняются нажатием клавиш 2 и 3,

при этом следует помнить, что не все

видеокарты поддерживают режим

работы с трёхмерной графикой (не�

обходима видеокарта с поддержкой

DirectX9.0C и Shared Mode 3.0). Итак,

после нажатия клавиши 3 программа

переходит в трёхмерный режим ра�

боты, и плата отображается синим

цветом. Теперь необходимо вклю�

чить отображение STEP�моделей, ко�

торое выполняется через панель

Project (см. рис. 3). Далее можно раз�

местить модель STEP в рабочей облас�

ти, для чего выполним команду Place
> 3D Body и на экране появится диа�

лог 3D Body. В появившемся окне вы�

бираем тип модели Generic STEP
Model и в нижней части нажимаем

кнопку Link to Step Model.
После предложения создать ссылку

на модель откроется окно, в котором

показана ранее заданная папка и все

хранящиеся в ней модели. В списке

выбираем модель плата.STEP и нажи�

маем кнопку ОК. Теперь в диалоге 3D
Body нажимаем кнопку ОК и разме�

щаем модель в рабочей области на�

жатием ЛКМ. После размещения мо�

дели программа предлагает устано�

вить следующую модель; в нашем

случае следует отказаться от этого на�

жатием кнопки Cancel. Последним

шагом необходимо указать, что до�

бавленная модель в формате STEP яв�

ляется платой, для чего выполним ко�

манду Design > Board Shape > Define
from 3D Body и два раза щёлкнем

мышью на добавленной модели. В ре�

зультате будет выведено сообщение, в

котором предлагается задать контур

платы из выбранной модели, с чем

следует согласиться.

Теперь плата существует в трёхмер�

ном виде со ссылкой на модель STEP, и

её можно вращать во всех плоскостях

нажатием клавиши Shift, после чего

на экране появится «шар со стрелка�

ми» (см. рис. 4), на котором располо�

жены кнопки управления поворотом:

● при наведении курсора на стрелки

и движении мыши с нажатой пра�

вой клавишей будет осуществлять�

ся поворот в указанном стрелкой

направлении;

● при наведении курсора на дуги и

движении мыши с нажатой правой

клавишей будет осуществляться по�

ворот в плоскости рабочей области;

● при наведении курсора на точку и

движении мыши с нажатой правой

клавишей будет осуществляться

свободное вращение.

В результате описанных выше

действий мы получили плату в Altium

Designer со ссылкой на модель STEP.

Следует отметить, что круглые отве�

рстия, которые были созданы в меха�

нической САПР, конвертировались в

контактные площадки со свойствами

обычных крепёжных отверстий. Если

на последующем этапе проектирова�

ния модель платы будет изменена в

той программе, в которой она была

создана, то в Altium Designer при об�

ращении к этой модели будет выдано

сообщение, показанное на рисунке 5.

В сообщении предлагается обновить

модель платы в соответствии с исход�

ной моделью в формате STEP.

Кроме инструментов по созданию

контура печатной платы в выпадаю�

щем меню Design > Board Shape содер�

жатся команды для формирования

вырезов в плате и несколько команд

для редактирования ранее созданно�

го контура платы.

РАБОТА СО СЛОЯМИ

После создания контура платы пе�

рейдём ко второму шагу разработки

конструктивных параметров платы,

на котором определяется порядок

расположения слоёв печатной платы.

Как известно, работа ведётся с нес�

колькими слоями печатной платы:

топология проводников разрабаты�

вается на одних слоях, пасты и маски

наносятся в других, и т.д. В програм�

ме P�CAD все слои делились на три

вида: Signal (сигнальные), Plane (эк�

ранные) и NonSignal (не сигнальные).

В программе Altium Designer похожее

деление, за исключением того, что не

сигнальные слои делятся на группы

по функциональному назначению.

Просмотр всех существующих сло�

ёв проекта и управление их отобра�

жением выполняется в окне View

Configurations, которое вызывается

командой Design > Board Layer&Colors
или нажатием клавиши L. Если эта
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Рис. 4. Кнопки поворота платы в трёхмерном

формате

Рис. 5. Сообщение об обновлении модели

Рис. 6. Настройки отображения слоёв



клавиша была нажата во время рабо�

ты в двумерном режиме, то окно на

экране будет выглядеть согласно ри�

сунку 6. Здесь в правой части показа�

ны группы слоёв редактора плат:

● Signal Layers (сигнальные слои) –

предназначены для создания топо�

логии проводящего рисунка;

● Internal Layers (экранные слои) –

предназначены для расположения

внутренних полигонов земли и пи�

тания, но не для прокладки провод�

ников, и информация в них отоб�

ражается инверсно;

● Mechanical Layers (графические

слои) – используются для вспомо�

гательной графической информа�

ции, например контур платы, и т.д.;

● Mask Layers – слои паяльной пасты

и защитной маски;

● Other Layers – дополнительные

слои, к которым относятся слой зо�

ны запрета и слои, отображающие

отверстия в плате;

● Silkscreen Layers – слои шелкогра�

фии, в которых располагается ин�

формация для маркировки на плате;

● System Layers (системные слои) –

правильно было бы назвать их

«системные цвета», к которым от�

носится цвет фона, сетки, соедине�

ния и др.

В данном окне нельзя добавлять и

удалять слои: здесь выполняется уп�

равление видимостью слоёв, для чего

используются кнопки в виде гиперс�

сылок под каждой группой слоёв. Нап�

ример, для сигнальных слоёв – кноп�

ки All On, All Off, Used On (Включить все,

Выключить все и Включить только ис�

пользуемые сигнальные слои).

Кроме страницы отображения сло�

ев, в окне View Configurations содер�

жатся вкладки Show/Hide и View
Options. На первой вкладке задаётся

режим отображения примитивов (см.

рис. 7), который может быть Final –

полное отображение, Draft – отобра�

жение в виде контура, Hidden –

скрыть примитивы. На второй вклад�

ке (View Options) устанавливаются до�

полнительные настройки отображе�

ния, из которых на данном этапе сле�

дует обратить внимание на параметр

Origin Marker, который включает

отображение начала координат. За�

кроем окно View Configuration нажа�

тием кнопки ОК.

Добавление новых слоёв и управ�

ление их положением в стеке печат�

ной платы производится в окне, ко�

торое вызывается командой Design >

Layer Stack Manager (см. рис. 8). В

данном окне показана структура пе�

чатной платы, на которой видно рас�

положение сигнальных и внутрен�

них экранных слоев. В правой части

окна отображается набор команд

для управления порядком располо�

жения слоёв. Кнопки Add Layer и Add
Plane добавляют сигнальный и эк�

ранный слои соответственно; всего

в программе Altium Designer может

быть создано 32 сигнальных и 16 эк�

ранных слоёв. Использование эк�

ранных слоёв (Plane Layer) изна�

чально не востребовано в практике

большинства отечественных предп�

риятий, т.к. вызывает трудности в ис�

пользовании. Во�первых, на таких

61СОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 8 2008 WWW.SOEL.RU

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ

Рис. 7. Переключение режимов отображения

примитивов

реклама



слоях нельзя создавать проводники;

во�вторых, не всегда удобно рабо�

тать с инверсно отображёнными

слоями.

Для расположения внутренних по�

лигонов питания и земли использу�

ются обычные сигнальные слои, ко�

торые обладают большей гибкостью

при работе. Кнопки Move Up и Move
Down (см. рис. 8) перемещают вы�

бранный слой вверх и вниз по спис�

ку. Для изменения свойств слоя мож�

но выполнить двойное нажатие ЛКМ

на его названии или использовать

кнопку Properties.

При намерении разработчика про�

вести анализ целостности сигнала

(команда меню Tools > Signal Integrity)

необходимо правильно указать сле�

дующую информацию. Для сигналь�

ных слоёв: Name – задаваемое поль�

зователем название слоя; Copper
thickness – толщина слоя металлиза�

ции, необходимая для анализа цело�

стности сигналов. Для внутренних

слоев питания и заземления: Name –

задаваемое пользователем название

слоя; Copper thickness – толщина слоя

металлизации, необходимая для ана�

лиза целостности сигналов. Для подло�

жек и изолирующих слоев: Material –

тип используемого материала; Thick�
ness – толщина диэлектрического

слоя, необходимая для анализа цело�

стности сигналов; Dielectric constant –

относительная диэлектрическая

проницаемость материала, необхо�

димая для анализа целостности сиг�

налов.

При формировании стека слоёв

конструктор должен определить па�

ры слоёв для сверления отверстий

(drill�pairs). Термин drill�pairs отно�

сится к двум слоям, участвующим в

сверлении (начальный и конечный

слой). Если на плате не применяются

глухие и скрытые переходные отвер�

стия, то в проекте присутствует толь�

ко одна пара слоёв сверления, состоя�

щая из верхнего и нижнего слоёв. Эта

пара устанавливается по умолчанию

и не подлежит ни удалению, ни моди�

фикации.

Пары слоёв сверления задаются 

в диалоговом окне Drill�Pair Mana�
ger, которое вызывается нажатием

кнопки Drill�Pair в диалоговом окне

Layer Stack Manager. При использо�

вании в проекте глухих и скрытых

переходных отверстий, пары слоёв

сверления должны быть определе�

ны с учётом используемого стиля

стека слоёв в строгом соответствии

с требованиями представителей

производства.

КРЕПЁЖ И ЗОНЫ ЗАПРЕТА

Последние действия на подготови�

тельном этапе разработки печатной

платы – это установка крепёжных от�

верстий и формирование зон запре�

та для металлизации. Крепёжные от�

верстия определяются командой

Place > Pad как обычные контактные

площадки. После запуска команды

размещения отверстий следует на�

жать клавишу Tab, в свойствах указать

нулевые значения в параметрах фор�

мы контактной площадки (Size and
Shape) и при необходимости отклю�

чить металлизацию внутри отверс�

тия (Plated). Следует отметить, что

при формировании контура платы

посредством импорта модели платы

в формате STEP были автоматически

созданы отверстия, в свойства кото�

рых включена металлизация и сфор�

мирован поясок металлизации, рав�

ный диаметру отверстия.

Для расположения зон запрета для

металлизации используется группа

команд Place > Keepout, в которой со�

держатся инструменты формирова�

ния линий запрета и полигонов за�

прета. Исторически сложилось, что

зоны запрета в виде линий (а также

дуг) не воспринимаются автомати�

ческими трассировщиками Specctra и

Situs, поэтому рекомендуется их вы�

полнять только с помощью команды

Place > Keepout > Solid Region. Кроме

необходимости использовать зоны

запрета только в виде полигона сле�

дует отслеживать слой, на котором

выполнена графика, относящаяся к

Keepout (зоне запрета).

При размещении зоны запрета,

действующей на все сигнальные слои

брать слой Keep�Out layer; в против�

ном случае в этом окне придётся выб�

рать конкретный слой, на который
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Рис. 9. Свойства зоны запрета

Рис. 10. Запуск мастера создания печатных

плат

Рис. 11. Мастер создания печатных плат

Рис. 8. Управление стеком слоёв



оказывает действие данная зона зап�

рета. Зону запрета можно создать и

для определённой цепи, которая ука�

зывается в окне Net свойств полигона

(см. рис. 9).

Итак, мы рассмотрели комплекс

мероприятий по формированию

конструктивных особенностей пе�

чатной платы. Все описанные выше

действия можно выполнить, исполь�

зуя мастер создания печатных плат, в

котором параметры платы, создавае�

мые вручную, будут сгенерированы

автоматически путём пошагового

ввода информации о плате.

МАСТЕР СОЗДАНИЯ ПЕЧАТНЫХ

ПЛАТ

Вернёмся к начальному этапу и

создадим плату для данного проекта

с помощью мастера печатных плат,

для чего выберем команду PCB Board
Wizard в панели File (см. рис. 10).

Появившийся мастер PCB Board
Wizard последовательно запрашива�

ет информацию о печатной плате,

которая затем оформляется в виде

конструктивных параметров и пра�

вил проектирования. Для продолже�

ния в появившемся окне нажмём

кнопку Next. В следующем окне будет

предложено выбрать систему еди�

ниц измерения, – в нашем случае это

метрическая система. Нажмём кноп�

ку Next. Далее будет предложен спи�

сок существующих шаблонов стан�

дартных промышленных печатных

плат; поскольку шаблон отсутствует,

выбираем Custom (пустой бланк).

Появляется окно, в котором необхо�

димо задать форму и размеры буду�

щей платы (см. рис. 11). В правой

части данного окна задаётся толщи�

на линий прорисовки границы пла�

ты (Boundary Track Width) и размеров

(Dimension Line Width), а также отступ

от края платы (Keepout Distance From
Board Edge).

Следующее окно предложит вы�

брать число сигнальных слоёв, а

также внутренних слоёв питания и

заземления. Наша плата будет иметь

только два сигнальных слоя, поэто�

му в поле Signal Layers следует ввес�

ти число 2, а в поле Power Planes –

число 0. Для продолжения нажмём

кнопку Next. Далее следует опреде�

лить тип переходных отверстий.

Поскольку мы проектируем прос�

тую двухстороннюю плату, выберем

тип Thru�hole Vias (сквозные пере�

ходные отверстия). Заметим, что

Altium Designer позволяет использо�

вать на многослойных платах сле�

пые и глухие переходные отверстия,

в том числе и по технологии

Microvia. Для использования слепых

и глухих переходов в текущем окне

следует выбрать параметр Blind and
Burier Vias Only.

В следующем окне необходимо

выбрать преобладающую техноло�

гию монтажа компонентов (поверх�

ностный или монтаж в отверстия).

При выборе параметра Thru�hole com�
ponents (монтаж в отверстия) ниже

указывается допустимое число про�

водников между смежными контакт�

ными площадками. Если был выбран

параметр Surface�mount components
(поверхностный монтаж), ниже ука�

зывается, разрешено или нет двух�

стороннее размещение SMD�компо�

нентов.

На следующем шаге требуется за�

дать размеры объектов на печатной

плате, которые будут преобразованы

мастером в правила проектирования

(см. рис. 12). Здесь задаются мини�

мально допустимые: ширина провод�

ника (Track Size), диаметр площадки

переходного отверстия (Via Width),

диаметр переходного отверстия (Via
Hole Size) и зазор между проводника�

ми (Clearance). Для простоты оставим

значения по умолчанию. Нажмём

кнопку Next. Последнее диалоговое

окно сообщает, что создание заготов�

ки платы завершено. Если необходи�

мо внести исправления, то с по�

мощью кнопки Back можно вернуть�

ся в соответствующее окно. Если исп�

равления не требуются, нажимаем

кнопку Finish.

После описанных действий откро�

ется файл платы созданного шаблона

с базовыми настройками. Описан�

ный выше мастер удобен для созда�

ния печатных плат, имеющих прос�

той контур.

Итак, мы рассмотрели варианты

разработки конструктива платы и по�

дошли к основной стадии проектиро�

вания печатной платы. В следующей

статье будут рассмотрены вопросы

передачи информации из схемы на

плату, формирование классов раз�

личных объектов и разработка пра�

вил проектирования.

Для более подробного изучения ма�

териала рекомендуется просмотреть

следующие файлы документации

Altium Designer: TR0112 PCB Editor and

Object Reference.pdf, TU0132 Integrating

MCAD Objects and PCB Designs.pdf.
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Рис. 12. Мастер создания печатных плат

(русифицированный интерфейс)
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